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FCC Information

WARNING: FCC Regulations state that any unauthorized changes or modifications to this equipment not expressly approved by the manufacturer could void 
the user’s authority to operate this equipment. 

Class B Declaration of Conformity

This equipment has been tested and found to comply with the limits for a class B digital device, pursuant to Part 15 of the FCC rules. These limits are designed 
to provide reasonable protection against harmful interference in a residential installation. This equipment generates, uses and can radiate radio frequency energy 
and if not installed and used in accordance with the instructions, may cause harmful interference to radio communications. However, there is no guarantee that 
interference will not occur in a particular installation. 

If this equipment does cause harmful interference to radio or television reception, which can be determined by turning the equipment off and on, the user is 
encouraged to try to correct the interference by one or more of the following measures:

Reorient or relocate the receiving antenna.

Increase the separation between the equipment and receiver.

Connect the equipment into an outlet on a circuit different from that to which the receiver is connected.

Consult the dealer or an experienced radio/TV technician for help.

In order to maintain compliance with FCC regulations, shielded cables must be used with this equipment. Operation with non-approved equipment or unshielded 
cables is likely to result in interference to radio and TV reception. The user is cautioned that changes and modifications made to the equipment without the 
approval of manufacturer could void the user’s authority to operate this equipment.

Industry Canada Class B Notice

This Class B digital apparatus complies with Canadian ICES-003.

Avis de Conformation Classe B de l’Industrie Canada 

Cet appareil numérique de la Classe B est conforme à la norme NMB-003 du Canada.

Certificate by Manufacturer/Importer

This is to certify that the FC07 is shielded against radio interference in accordance with the provisions of VFG 243/1991. The German Postal Services have been 
advised that this device is being put on the market and that they have been given the right to inspect the series for compliance with the regulations.

Bescheinigung des Herstellers/Importeurs

Hiermit wird bescheinigt, dass der FC07 im Übereinstimmung mit den Bestimmungen der VFG 243/1991 funkentstört ist. Der Deutschen Bundespost wurde 
das Inverkehrbringen dieses Gerätes angezeigt und die Berechtigung zur Überprüfung der Serie auf Einhaltung der Bestimmungen eingeräumt.

RFI Compliance Notice

This equipment has been tested concerning compliance with the relevant RFI protection requirements both individually and on system level (to simulate normal 
operation conditions). However, it is possible that these RFI Requirements are not met under certain unfavorable conditions in other installations. It is the user 
who is responsible for compliance of his particular installation.

Dieses Gerät wurde sowohl einzeln als auch in einer Anlage, die einen normalen Anwendungsfall nachbildet, auf die Einhaltung der Funkentstörbestimmungen 
geprüft. Es ist jedoch möglich, dass die Funkentstörbestimmungen unter ungünstigen Umständen bei anderen Gerätekombinationen nicht eingehalten werden. 
Für die Einhaltung der Funkentstörbestimmungen einer gesamten Anlage, in der dieses Gerät betrieben wird, ist der Betreiber verantwortlich.

Compliance with applicable regulations depends on the use of shielded cables. It is the user who is responsible for procuring the appropriate cables.

Die Einhaltung zutreffender Bestimmungen hängt davon ab, dass geschirmte Ausführungen benützt werden. Für die Beschaffung richtiger Ausführungen ist der 
Betreiber verantwortlich.

Software License Agreement

YOU SHOULD CAREFULLY READ THE FOLLOWING TERMS AND CONDITIONS BEFORE USING THIS SOFTWARE. IF YOU DO NOT 
AGREE TO THE TERMS AND CONDITIONS OF THIS AGREEMENT, DO NOT USE THE SOFTWARE. INSTALLING OR USING THE 
SOFTWARE INDICATES THAT YOU AGREE TO AND ACCEPT THE TERMS OF THIS AGREEMENT. IF YOU DO NOT AGREE TO ACCEPT 
THE TERMS OF THIS AGREEMENT YOU MAY RETURN THE UNUSED SOFTWARE FOR A FULL REFUND TO THE PLACE OF PURCHASE. 



License

EFI grants you a non-exclusive license to use the software (“Software”) and accompanying documentation (“Documentation”) included with the Product. The 
Software is licensed, not sold. You may use the Software solely for your own customary business or personal purposes. You may not rent, lease, sublicense or lend 
the Software. You may, however, permanently transfer all of your rights under this Agreement to another person or legal entity provided that: (1) you transfer to 
the person or entity all of the Software and Documentation (including all copies, updates, upgrades, prior versions, component parts, the media and printed 
materials, and this Agreement); (2) you retain no copies of the Software and Documentation, including copies stored on a computer; and (3) the recipient agrees 
to the terms and conditions of this Agreement. 

You may not make or have made, or permit to be made, any copies of the Software or portions thereof, except as necessary for backup or archive purposes in 
support of your use of the Software as permitted hereunder. You may not copy the Documentation. You may not attempt to alter, disassemble, decompiler, decrypt 
or reverse engineer the Software.

Proprietary Rights

You acknowledge that the Software is proprietary to EFI and its suppliers and that title and other intellectual property rights therein remain with EFI and its 
suppliers. Except as stated above, this Agreement does not grant you any right to patents, copyrights, trade secrets, trademarks (whether registered or unregistered), 
or any other rights, franchises or licenses in respect of the Software. You may not adopt or use any trademark or trade name which is likely to be similar to or 
confusing with that of EFI or any of its suppliers or take any other action which impairs or reduces the trademark rights of EFI or its suppliers.

Confidentiality

You agree to hold the Software in confidence, disclosing the Software only to authorized users having a need to use the Software as permitted by this Agreement 
and to take all reasonable precautions to prevent disclosure to other parties.

Remedies and Termination

Unauthorized use, copying or disclosure of the Software, or any breach of this Agreement will result in automatic termination of this license and will make available 
to EFI other legal remedies. In the event of termination, you must destroy all copies of the Software and all of its component parts. All provisions of this Agreement 
relating to disclaimers of warranties, limitation of liability, remedies, damages, and EFI’s proprietary rights shall survive termination.

Limited Warranty and Disclaimer

EFI warrants to the original purchaser (“Customer”) for thirty (30) days from the date of original purchase from EFI or its authorized retailer that the Software 
will perform in substantial conformance to the Documentation when the Product is used as authorized by EFI’s specifications. EFI warrants the media containing 
the Software against failure during the above warranty period. EFI makes no warranty or representation that the Software will meet your specific requirements, 
that the operation of the Software will be uninterrupted or error free, or that all defects in the Software will be corrected. EFI makes no warranty, implied or 
otherwise, regarding the performance or reliability of any third party products (software or hardware) not provided by EFI. THE INSTALLATION OF ANY 
THIRD PARTY PRODUCTS OTHER THAN AS AUTHORIZED BY EFI WILL VOID THIS WARRANTY. IN ADDITION, USE, MODIFICATION, 
AND/OR REPAIR OF THE PRODUCT OTHER THAN AS AUTHORIZED BY EFI WILL VOID THIS WARRANTY.

EXCEPT FOR THE ABOVE EXPRESS LIMITED WARRANTY, EFI MAKES AND YOU RECEIVE NO WARRANTIES OR CONDITIONS ON THE 
SOFTWARE, EXPRESS, IMPLIED, STATUTORY, OR IN ANY OTHER PROVISION OF THIS AGREEMENT OR COMMUNICATION WITH YOU, 
AND EFI SPECIFICALLY DISCLAIMS ANY IMPLIED WARRANTY OR CONDITION OF MERCHANTABILITY OR FITNESS FOR A PARTICULAR 
PURPOSE OR NONINFRINGEMENT OF THIRD PARTY RIGHTS. 

Limitation of Liability

TO THE MAXIMUM EXTENT PERMITTED BY LAW, EFI AND ITS SUPPLIERS SHALL NOT BE LIABLE FOR ANY DAMAGES, INCLUDING 
LOSS OF DATA, LOST PROFITS, COST OF COVER OR OTHER SPECIAL, INCIDENTAL, CONSEQUENTIAL OR INDIRECT DAMAGES 
ARISING FROM THE SALE, INSTALLATION, MAINTENANCE, USE, PERFORMANCE OR FAILURE OF THE SOFTWARE, HOWEVER CAUSED 
AND ON ANY THEORY OF LIABILITY. THIS LIMITATION WILL APPLY EVEN IF EFI HAS BEEN ADVISED OF THE POSSIBILITY OF SUCH 
DAMAGE. YOU ACKNOWLEDGE THAT THE PRICE OF THE PRODUCT REFLECTS THIS ALLOCATION OF RISK. BECAUSE SOME 
JURISDICTIONS DO NOT ALLOW THE EXCLUSION OR LIMITATION OF LIABILITY FOR CONSEQUENTIAL OR INCIDENTAL DAMAGES, 
THE ABOVE LIMITATION MAY NOT APPLY TO YOU.

Export Controls

You agree that you will not export or re-export the Software in any form in violation of any applicable laws or regulations of the United States or the country in 
which you obtained them.

U.S. Government Restricted Rights:

The Software and Documentation are provided with RESTRICTED RIGHTS. Use, duplication, or disclosure by the United States Government is subject to 
restrictions as set forth in subparagraph (c)(1)(ii) of the Rights in Technical Data and Computer Software clause at DFARS 252.227-7013 or subparagraphs (c)(1) 
and (2) of the Commercial Computer Software Restricted Rights at 48 CFR 52.227-19, as applicable.



General

The laws of the State of California govern this Agreement. You agree that this Agreement shall not be subject to the United Nations Convention on Contracts for 
the International Sale of Goods (1980). This Agreement is the entire agreement held between us and supersedes any other communications or advertising with 
respect to the Software. If any provision of this Agreement is held invalid, the remainder of this Agreement shall continue in full force and effect.

If you have any questions, please see EFI’s web site at www.efi.com.

Electronics For Imaging
303 Velocity Way
Foster City, CA 94404
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ix Media Pack

Welcome to Getting Started. This manual describes installing the user software for 
the Fiery 3850C™ and setting up printing from Windows and Mac OS computers. 
For information about setting up network servers and clients to use the Fiery 3850C, 
see the Configuration Guide. For general information on using the printer, your 
computer, your application software, or your network, see the manuals that 
accompany those products.

NOTE: The term “Windows 9x/Me” is used to refer to Windows 95/98/Me. Individual 
differences are noted. Windows XP is supported. If you are using Windows XP, follow 
the procedures for Windows 2000.

Media Pack
Your Fiery 3850C includes:

• User Software CD

• Network Utilities CD

• Documentation CD

• Printed Getting Started

• Printed Configuration Guide

• Printed Release Notes 

About the documentation
This manual is part of the set of Fiery 3850C documentation, which includes the 
following manuals for users and system administrators:

• The Configuration Guide explains basic configuration and administration of the 
Fiery 3850C for the supported platforms and network environments. It also 
includes guidelines for setting up UNIX, Windows NT 4.0, and Novell NetWare 
servers to provide Adobe PostScript printing services to clients.

Introduction



x Introduction

• Getting Started describes how to install software to enable users to print to the 
Fiery 3850C. Specifically, it describes installation of the PostScript and PCL printer 
drivers, printer description files, and other software provided on the User Software 
CD. It also explains how to connect each user to the network.

• The Printing Guide describes the printing features of the Fiery 3850C for users who 
send jobs via remote workstations on the network or via a direct parallel port 
connection.

• The Color Guide provides information on managing the color output of the 
Fiery 3850C. It addresses concepts and issues associated with printing to the 
Fiery 3850C and outlines key workflow scenarios. This manual explains how to 
calibrate your copier and take advantage of the ColorWise® color management 
system as well as features in ColorWise Pro Tools.

• The Job Management Guide explains the functions of the Fiery® client utilities, 
including Command WorkStation™, and how they can be used to manage jobs. 
This book is intended for an operator or administrator, or a user with the necessary 
access privileges, who needs to monitor and manage job flow, and troubleshoot 
problems that may arise. 

• Release Notes provide last-minute product information and workarounds for some of 
the problems you may encounter.

NOTE: Printing Guide, Job Management Guide, and Color Guide are on the 
Documentation CD only. Getting Started and the Configuration Guide are both printed 
and on the Documentation CD.

Specifications
• Supports Windows 9x/Me, Windows NT, Windows 2000/XP, and Mac OS

NOTE: For Windows XP, see instructions for Windows 2000.

• Pentium III 700MHz CPU

• 128MB RAM

• 10 GB (or more) hard disk drive

• Supports AppleTalk, TCP/IP, and IPX protocols simultaneously

• Supports Port 9100

• Supports parallel port communication



xi User software

• Supports twisted pair (Fast Ethernet 100BaseTX or Ethernet 10BaseT)

• Supports Adobe PostScript 3

• Includes 136 fonts (126 Adobe Type 1 PostScript and 10 TrueType)

In addition, two Adobe Multiple Master fonts are included and are used for font 

substitution in PDF files.

• Supports PCL 5c printing (Windows 9x/Me, Windows NT, and Windows 
2000/XP)

• Includes 46 PCL fonts

• Fiery WebTools™

• Command WorkStation software (available as an option)

Command Workstation is available for Windows only.

• ColorWise Pro Tools

User software
The full set of Fiery 3850C user software is provided on the User Software CD. 

Adobe PostScript 
Printer Driver

Enables you to print to the Fiery 3850C from 
Windows 9x/Me, Windows NT 4.0, and Mac OS 
computers; also supports special Fiery and PostScript 3 
features. Windows 2000/XP users should use the 
Microsoft PostScript Printer Driver provided with those 
applications.

PostScript Printer 
Description file 
(PPD)

For use with the PostScript printer driver that allows the 
Fiery 3850C to appear in popular applications’ Print and 
Page Setup dialog boxes. The Fiery 3850C PPDs provide 
information about the Fiery 3850C and your particular 
printer model to the application and printer driver you 
are using.
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PostScript Fonts
(Mac OS only) 

PostScript screen and printer fonts that correspond to 
the 136 PostScript printer fonts installed on the 
Fiery 3850C (126 Adobe Type 1 and 10 TrueType). See 
Appendix B of the Printing Guide for a complete list of 
PostScript and PCL fonts installed on the Fiery 3850C. 

PCL Printer Driver Enables you to print to the Fiery 3850C from 
Windows 9x/Me/NT/2000 computers; supports all 
special Fiery 3850C PCL 5c print features.

ColorWise Pro Tools ICC-open color management and calibration tools; 
enables you to edit and download ICC profiles.

Calibration files Includes measurements files and targets that you can use 
with ColorWise Pro Tools.

Color reference files Reference pages that you can print to view the range of 
colors available on your Fiery 3850C. For the most 
predictable color results, refer to these pages when 
defining colors in applications. For more information on 
color management, see the Color Guide.

MRJ (Mac OS only) Mac OS Runtime for Java installer v 2.2.4 MRJ is 
required by all Java-based Fiery utilities. When installing 
these utilities, if MRJ is not detected the MRJ installer is 
automatically launched.

JavaVM (Windows XP 
only)

JavaVM for Windows XP is required to run Fiery 
WebTools.



xiii System requirements

System requirements
To install the Fiery 3850C user software on a Windows or Mac OS computer, the 
computer must be equipped with a built-in or external CD-ROM drive.

Windows

To print to the Fiery 3850C, you need:

• A Windows-based computer with an 80486, AMD, or Pentium processor

• Windows 9x/Me, Windows NT 4.0, or Windows 2000/XP

• At least 32MB of RAM for Windows 9x/Me

• At least 32MB of RAM for Windows NT 4.0

• At least 128MB of RAM for Windows 2000/XP

With Microsoft Windows 9x/Me, you also need:

• IPX/SPX or TCP/IP networking protocol installed

• Adobe PostScript Printer Driver (included with the user software)

• PCL Printer Driver (included with the user software)

With Microsoft Windows NT 4.0 and Windows 2000, you also need:

• IPX/SPX, TCP/IP, or AppleTalk networking protocol installed

• Microsoft PostScript Printer Driver for Windows 2000 (included with your 
Windows 2000 operating system)

• Adobe PostScript Printer Driver (included with the user software)

• PCL Printer Driver for Windows NT 4.0 (included with the user software)

To use ColorWise Pro Tools, you also need:

• Either Windows 9x/Me, Windows 2000, or Windows NT 4.0 with NT Service Pack 
5 or later

• At least 64MB of RAM
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To use Fiery WebTools, you also need:

• Either Netscape Communicator v4.5 or later, and Java enabled or Microsoft Internet 
Explorer v4.0.1 and Service Pack 1 or later, with Java enabled

• A monitor and video memory that supports 16-bit color at a minimum resolution of 
800x600

• A TCP/IP-enabled network and the IP address or DNS name of the Fiery 3850C

Mac OS

To print to the Fiery 3850C, you need:

• A Mac OS-based computer and Apple System software 8.6 or later

• At least 128MB of RAM

• EtherTalk installed

• Adobe PostScript Printer Driver version 8.5 or later (version 8.7.2 is included with 
the user software)

To use ColorWise Pro Tools, you also need:

• A Mac OS-based computer and Apple System software version 8.6 or later

• At least 128MB of RAM

To use Fiery WebTools, you also need:

• Netscape Communicator v4.5 or later, with Java enabled, or Internet Explorer 
v4.0.1 or later, with Java enabled

• A monitor and video memory that supports 16-bit color at a minimum resolution of 
800x600

• A TCP/IP-enabled network and the IP address or DNS name of the Fiery 3850C
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UNIX (TCP/IP)

To print to the Fiery 3850C with a UNIX workstation, you need:

• A workstation with standard TCP/IP connectivity (for example, Sun SPARCStation 
or Silicon Graphics workstation with Solaris version 7.x)

• TCP/IP printing software that conforms to RFC1179 (Berkeley lpd protocol)

Parallel port

To print to the Fiery 3850C using the parallel port, you need:

• A Windows computer with an 80486, AMD, or Pentium processor

• At least 16MB of RAM for Windows 95

• At least 32MB of RAM for Windows 98/Me

• At least 32MB of RAM for Windows NT 4.0

• At least 128MB of RAM for Windows 2000/XP

• The parallel cable

The included IEEE-1284 cable has a 36-pin mini C connector on one end and a 

25-pin D-sub connector on the other.

NOTE: Do not use a parallel cable that is longer than 10 feet (3 meters).

IPX (Novell)

To use the Fiery 3850C with an IPX (Novell) network, you need:

• A Novell server

• Novell NetWare software version 3.x, 4.x, or 5.x

• Support for Ethernet SNAP, Ethernet II, Ethernet 802.3, Ethernet 802.2 frame 
types
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Command WorkStation (Option)

To run the Command WorkStation application (available as an option) from a remote 
workstation, you need:

• A Windows-based computer with a 200MHz Pentium processor (at minimum)

• Windows 9x/Me, Windows NT 4.0 with NT Service Pack 5, or Windows 2000/XP

• TCP/IP networking protocol installed

• A video adapter card with at least 2MB of video memory

• At least 64MB of RAM

• 100MB of available hard disk space

• A 2x or faster CD-ROM drive

• A 17" monitor that supports 16-bit color at a minimum resolution of 1024x768



1 Setting up PostScript or PCL printing with Windows 9x/Me

This chapter describes installing software and setting up printing from a 
Windows-based computer running Windows 9x/Me, Windows NT 4.0, or 
Windows 2000/XP.

NOTE: If you are using Windows XP, follow the procedures for Windows 2000.

The general steps for installing the software are: 

• Install the PostScript printer driver or PCL5c printer driver (Windows 9x/Me, 
Windows NT 4.0, or Windows 2000/XP) and corresponding printer driver files.

• Set up the printer driver to communicate with the Fiery 3850C.

• Install ColorWise Pro Tools.

• Configure the connection for ColorWise Pro Tools.

• Copy additional files from the User Software CD as needed.

Setting up PostScript or PCL printing with 
Windows 9x/Me
To set up the Fiery 3850C as a PostScript or PCL printer, you must install the 
PostScript or PCL printer drivers for Windows 9x/Me and the corresponding printer 
description files from the User Software CD. You must also configure a particular type 
of print connection between the workstation and the Fiery 3850C. 

If AutoRun is enabled on your computer, the installer runs automatically when the 
User Software CD is inserted in the CD ROM drive. You can specify which files to 
install on your computer.

NOTE: If AutoRun is not enabled, you can run the installer by double-clicking the 
CD-ROM drive icon in My Computer, or by double-clicking the Setup.exe file in the 
Installr folder on the User Software CD.

Installing 
User Software 
on a Windows 
Computer



2 Installing User Software on a Windows Computer

If you are printing using SMB (Server Message Block), you can connect to the 
Fiery 3850C and install the printer drivers in a single procedure. To configure the 
Fiery 3850C for SMB printing, see “Setting up SMB printing with Windows 9x/Me” 
on page 15, “Setting up SMB printing with Windows NT 4.0” on page 32, or “Setting 
up SMB printing on Windows 2000” on page 46.

If you are printing through a Novell server, see “To set up IPX (Novell) printing with 
Windows 9x/Me” on page 14, “To set up IPX (Novell) printing for Windows NT 4.0” 
on page 29, or “To set up IPX (Novell) printing for Windows 2000” on page 43.

TO INSTALL THE POSTSCRIPT OR PCL PRINTER DRIVER USING 
AUTORUN OR INSTALLER

1. Insert the User Software CD in your CD-ROM drive.

2. Follow the instructions on screen.

3. Choose from the Typical, Compact, or Custom installation options.

Choose this To install

Typical The PostScript printer driver and printer description 
files for the Fiery 3850C and the PCL printer driver and 
printer description files for the Fiery 3850C.

Compact The PostScript printer driver and printer description 
files.

Custom You can select from the following:
PostScript printer driver and printer description files
PCL printer driver and printer description file



3 Setting up PostScript or PCL printing with Windows 9x/Me

TO INSTALL THE POSTSCRIPT OR PCL PRINTER DRIVER FOR 
WINDOWS 9X/ME USING THE ADD PRINTER WIZARD

NOTE: The procedure for installing printer drivers is similar for the PostScript and PCL 
printer drivers. For the purpose of the following instructions, the PostScript printer 
driver is used in screen captures.

1. Click Start, choose Settings, and then choose Printers to display the Printers 

window.

2. Double-click the Add Printer icon, and click Next.

3. Specify whether you are printing using a Local printer, and click Next.

This procedure describes installing a printer locally. You can modify the connection 
later, according to your network type.

4. In the dialog box displaying lists of manufacturers and printers, click Have Disk.

The Install from Disk dialog box prompts you for the disk.

5. If you are installing from the CD, type the name of the CD-ROM drive (for example, 

D:\), and click Browse. 

To install the PostScript driver, browse to English\Prntdrvr\Ps_drvr\Win_98_ME.

To install the PCL driver, browse to English\Prntdrvr\Pcl_drvr\Win_98_ME.

Make sure “Oemsetup.inf” is selected.
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6. Click OK. 

The path is copied to the Install From Disk dialog box.

7. Verify the path is correct, and click OK.

8. In the Printers box, select the Fiery 3850C PS or PCL file and click Next.
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9. In the Available ports box, select the LPT1 port and click Next.

You will configure the port later, according to your network type.

10. Using a maximum of 31 characters, enter a name for the Fiery 3850C (or leave the 

default name) in the Printer Name box.

This name will be used in the Printers and queue windows.

NOTE: Entering more than 31 characters may cause printing problems with some 
network applications.

11. If you want the Fiery 3850C to be the default printer select Yes; if not, select No. 

Click Next.

12. Select No to printing the test page, and click Finish.

The necessary files are installed to your hard disk.

TO CONFIGURE INSTALLABLE OPTIONS ON THE FIERY 3850C FROM THE 
POSTSCRIPT OR  PCL PRINTER DRIVERS FOR WINDOWS 9X/ME

NOTE: The procedures for configuring installable options are similar for the PostScript 
and PCL printer drivers. For the purpose of the following instructions, the PostScript 
printer driver is used in screen captures.

1. In the Printers window, select the icon for the Fiery 3850C PostScript or PCL 

printer driver. 

Choose Properties from the File menu. 

2. Select the Accessories tab.
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3. Select an installed option from the Available Options list, and click Add to move 

the option to the Installed Options list.

Option Tray—Not Installed, Tray 3, Tray 3 and Tray 4, Tray 3 (LCT)

Finisher Option—Not Installed, 2 Tray Finisher, Mailbox

Duplex Unit—Not Installed, Installed

Punch Option—Not Installed, 2 and 3 holes, 2 and 4 holes, 4 holes

4. Click Apply.

5. Click OK.

You are ready for the instructions for connecting to your network type. See 
“Completing the Windows 9x/Me printer connection” on page 7. 
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Completing the Windows 9x/Me printer connection

To print from Windows 9x/Me, you need to:

• Set up network servers, if any

• Set up the Fiery 3850C to accept print jobs from your computer

• Configure a port on each Windows computer for the network 

Completing the Windows 9x/Me parallel port connection

Preparing a parallel port connection for Windows 95/98 requires specific BIOS 
settings on your computer and specific port and printer settings for Windows 95/98. 
In addition, a change to one of the Fiery 3850C Setup settings may be required if you 
choose to spool files to the Fiery 3850C rather than print directly.

TO PREPARE THE FIERY 3850C AND YOUR COMPUTER FOR 
PARALLEL PORT PRINTING

1. Connect the Fiery 3850C to the parallel port on your computer.

For instructions, see the Configuration Guide.

2. In Network Setup>Port Setup>Parallel Port Setup, set Enable Parallel Port to Yes.

For more information about Fiery 3850C Setup, see the Configuration Guide.

3. If you want to spool files to the Fiery 3850C, set Port Timeout in Seconds to 10.

If you want to print directly to the Fiery 3850C, set Port Timeout in Seconds to 5.

Setting this option to 10 seconds ensures that spooling is not interrupted due to 
timeout.

4. In your computer’s BIOS settings, set Parallel Port Mode to ECP.

To access the BIOS settings, restart the computer and press the key indicated on your 
monitor as soon as the computer starts up. You may have to scroll through several 
screens to reach the parallel port settings. After setting the Parallel Port Mode to ECP, 
save your changed setting and exit.
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TO PREPARE THE PRINTER FOR PARALLEL PORT PRINTING

1. Click the Start button, point to Settings, and click Printers.

2. Click the Fiery 3850C printer icon and choose Properties from the File menu.

3. Click the Details tab, and in the “Print to the following port” menu, select 

LPT 1: (ECP Printer Port).

NOTE: Check this selection carefully. It may read LPT 1: (Printer Port), which is not 
equivalent to LPT 1: (ECP Printer Port).

If this box does not read LPT 1: (ECP Printer Port), change the port setting now, as 
described in “To prepare the port for parallel port printing” on page 9 
(Windows 98/Me), and then return to this procedure. You may need your Windows 
System CD.

4. If you changed the selection in the “Print to the following port” menu, click 

Apply.

A Warning dialog box may appear, stating that fonts you downloaded to the previously 
selected port may be lost; click OK.

5. Click Spool Settings.
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6. Select either “Spool print jobs so program finishes printing faster” or 

“Print directly to the printer.”

The selection you make depends on the action you took in step 3 on page 7:

• If you set the Port Timeout in Seconds to 10, you can select either option; however, 
spooling is faster.

• If you set the Port Timeout in Seconds to 5, select “Print directly to the printer.”

7. Select “Disable bi-directional support for this printer” and click OK.

8. Click Apply.

You are now ready to print from your applications to the Fiery 3850C with the parallel 
port. To confirm the connection, print a Windows test page.

9. Click the General tab.

10. Click Print Test Page and click OK.

11. The Job Notes window appears. Enter user and job identification information for 

accounting purposes, or whatever information is required at your site, and click 

OK.

If the test page prints successfully, you are ready to print from the computer.

TO PREPARE THE PORT FOR PARALLEL PORT PRINTING IN WINDOWS 98/ME

1. Click the Start button, choose Settings, and then choose Control Panel.

2. Double-click System.

The System Properties window appears.

3. Click the Device Manager tab.
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4. Double-click Ports.

5. Double-click the port with LPT1 in its name.

6. In the (LPT1) Properties dialog box, click the Driver tab and then click Update 

Driver. 

The Update Device Driver Wizard appears.

7. Click Next.
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8. Choose “Display a list of all the drivers in a specific location, so you can select 

the driver you want,” then click Next.

9. Select “Show all hardware.”

10. From the Manufacturers list, select “(Standard port types).” From the Models list, 

select “ECP Printer Port” (not Printer Port). Click Next.

11. Click Yes in the Update Driver Warning dialog box.

12. Click Next.

Some files are copied.
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13. Click Finish, and close the Printer Port Properties and System Properties dialog 

boxes.

You must restart your computer in order to activate the new settings. After 
Windows 98/Me restarts, you can complete the procedure described in “To prepare the 
printer for parallel port printing” on page 8.

Completing the Windows 9x/Me IPX/SPX or IPX (Novell) connection

If you are printing through a Novell server, the Novell network and file server should 
be set up before you begin. The file server should be configured with a print server and 
print connection for the Fiery 3850C. For details, see your NetWare documentation 
and the Configuration Guide.

To print from Windows 9x/Me computers over IPX (Novell), you must first set up 
IPX/SPX protocols, and then configure the Fiery 3850C by choosing the IPX port 
type, and entering the settings for the port you use.

TO SET UP IPX/SPX PRINTING

1. Click the Start button, choose Settings, and then choose Control Panel.

2. Double-click the Network icon.

Make sure that IPX/SPX-compatible Protocol is listed in the Installed Network 
Components section.

For instructions, see your Windows 9x/Me documentation.
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3. Double-click the IPX/SPX-compatible Protocol icon.

4. Click the Advanced tab.

5. In the Property list, click Frame Type. In the Value pop-up menu, select the Frame 

Type that corresponds to the one set during Fiery 3850C Network Setup.
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If necessary, print the Configuration page from the Control Panel to check which 
Frame Type(s) are configured.

6. Click OK and close the Network Control Panel.

7. When prompted to restart your computer, click Yes.

TO SET UP IPX (NOVELL) PRINTING WITH WINDOWS 9X/ME

1. Click the Start button, choose Settings, and then choose Printers.

2. Right-click the Fiery 3850C printer icon and choose Properties from the File 

menu.

3. Click the Details tab and click Add Port.

A list of connection options is displayed.

4. In the Add Port dialog box, specify the network path, or click Browse for a 

display of your network environment.

5. If you are using a NetWare file server, double-click the icon of the NetWare file 

server you want to use for printing to the Fiery 3850C. 



15 Setting up PostScript or PCL printing with Windows 9x/Me

6. Click the printer icon labeled with the NetWare print queue you will use and click 

OK.

7. In the Add Port dialog box, verify that the network path is updated and click OK.

Your print jobs are transmitted to the specified print queue on the Novell file server. 
The Fiery 3850C polls the file server, and if jobs are present, they are transmitted to 
the Fiery 3850C.

To confirm the connection, you can print a Windows 9x/Me test page.

8. Click the General tab, click Apply, and click Print Test Page.

If the test page prints successfully, you are ready to print from the computer.

Setting up SMB printing with Windows 9x/Me

If you do not have a Novell network, you can print via SMB printing (also known as 
Windows printing or WINS printing). Printing by this method allows you to install 
the PostScript or PCL printer driver and printer description files, and print from your 
computer to a particular connection (Hold, Print, or Direct) on the Fiery 3850C. 
These instructions assume you have the TCP/IP protocol and Client for Microsoft 
Networks installed.

To set up printing to a second or third connection on Windows 9x/Me, you must 
install a new printer by repeating the procedure “To set up SMB printing on 
Windows 9x/Me” on page 16. If you install more than one printer, give each a 
descriptive name during printer driver installation, such as Aero-Print or Aero-Hold, 
so you can easily identify printers.

BEFORE YOU BEGIN

• Configure the Fiery 3850C for SMB printing in Network Service Setup>SMB Setup.

SMB printing is referred to as Windows Printing in Setup, on the Control Panel Map, 
and on the Configuration page. For more information, see the Configuration Guide.
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TO SET UP SMB PRINTING ON WINDOWS 9X/ME

1. Double-click the Network Neighborhood icon to display your network 

environment.

2. Browse for the printer you would like to print to.

The printer name you are browsing for is the name entered in Network Setup>Service 
Setup>Windows Setup>Server Name. Refer to the Configuration page for this 
information.

If you are not able to locate your Fiery 3850C, see your network administrator.

3. Double-click the name of the printer to display enabled print connections.

4. Double-click the name of the connection you want to print to.

The Printers dialog box appears, asking whether you would like to set up the printer.

5. Select Yes to install the PostScript or PCL printer driver and printer description file for 

the selected connection.

The Add Printer Wizard appears.
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6. Specify whether you print from MS-DOS based programs, and then click Next.

If you choose Yes, you will be prompted to capture a printer port before proceeding 
with the installation. See your Windows documentation for details.

7. In the dialog box displaying lists of manufacturers and printers, click Have Disk.

The Install from Disk dialog box prompts you for the disk.

8. If you are installing from the CD, type the name of the CD-ROM drive (for example, 

D:\), and click Browse. Browse to the appropriate folder:

To install the PostScript driver, browse to English\Prntdrvr\Ps_drvr\Win_9x_Me.

To install the PCL 5c driver, browse to English\Printdrvr\Pcl_drvr\Win_9x_Me.

Make sure “Oemsetup.inf” is selected.

The path is copied to the Install From Disk dialog box.

9. Verify the path is correct, and click OK.

10. In the Printers box, select the Fiery 3850C PS or PCL file and click Next.

11. Enter a name for the Fiery 3850C in the Printer name box, and choose whether to 

make it the default printer. Click Next.

12. Choose whether to print a test page, and then click Finish.

The necessary files are installed to your hard disk 

If the test page prints successfully, you are ready to print from the computer.

Setting up PostScript or PCL printing with 
Windows NT 4.0
To set up the Fiery 3850C as a PostScript or PCL printer, you must install the 
PostScript or PCL Printer Driver for Windows NT 4.0 and its corresponding printer 
description files. You must also configure a particular type of print connection between 
the workstation and the Fiery 3850C.

If AutoRun in enabled on your computer, the installer runs automatically when the 
User Software CD is inserted in the CD-ROM drive. You can specify which files to 
install on your computer.
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NOTE: If AutoRun is not enabled, you can run the installer by double-clicking the 
CD-ROM drive icon in My Computer, or by double-clicking the Setup.exe file in the 
Installr folder on the User Software CD.

The instructions below describe installing a printer locally. Adding a printer to a local 
system requires that you log in to your local Windows NT workstation (not the 
network server domain) and that you be a member of the Administrators group. The 
procedure for adding a network printer is similar to adding a port. This procedure is 
described in “Completing the Windows NT 4.0 TCP/IP and LPR connection” on 
page 27.

If you are printing using SMB (Server Message Block), you can connect to the 
Fiery 3850C and install the printer drivers in a single procedure. To configure 
the Fiery 3850C for SMB printing, see “Setting up SMB printing with Windows 
NT 4.0” on page 32.

TO INSTALL THE POSTSCRIPT OR PCL PRINTER DRIVER USING 
AUTORUN OR INSTALLER

1. Insert the User Software CD in your CD-ROM drive.

2. Follow the instructions on screen.

3. Choose from the Typical, Compact, or Custom installation options.

Choose this To install

Typical The PostScript printer driver and printer description 
files for the Fiery 3850C and the PCL printer driver and 
printer description files for the Fiery 3850C.

Compact Installs the PostScript printer driver and printer 
description files.

Custom Installs the files you select. You can select from the 
following:
PostScript printer driver and printer description files
PCL printer and printer description file
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TO INSTALL THE POSTSCRIPT OR PCL PRINTER DRIVER FOR 
WINDOWS NT 4.0 USING THE ADD PRINTER WIZARD

NOTE: The procedure for installing printer drivers is similar for the PostScript and PCL 
printer drivers. For the purpose of the following instructions, the PostScript printer 
driver is used in screen captures.

1. If you are installing from the CD, insert it into the CD-ROM drive.

2. Click Start in the Windows NT taskbar, choose Settings, and then choose Printers.

3. Double-click Add Printer.

4. To install a printer locally, select My Computer and click Next.

“My Computer” is available if you logged in to a computer on which you have 
Administrator privileges. If it is not available, you can add a network printer. The 
procedure is similar to adding a port (see page 27).
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5. Check LPT1: and click Next.

6. In the dialog box displaying lists of manufacturers and printers, click Have Disk.
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The Install from Disk dialog box prompts you for the disk.

If you are installing from the CD, type the name of the CD-ROM drive (for 

example, D:\), and click Browse.

To install the PostScript driver, browse to English\Prntdrvr\Ps_drvr\Win_NT 4x

To install the PCL driver, browse to English\Printdrvr\Pcl_drvr\Win_NT 4x.

Make sure “Oemsetup.inf” or “Oemsetup” is selected.

The path is copied to the Install from Disk dialog box.

7. Verify the path is correct, and click OK.
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8. In the Printers box, select the Fiery 3850C PS or PCL file and click Next.

9. Enter a name for the Fiery 3850C (or leave the default name) in the Printer name box, 

and choose whether you want the Fiery 3850C to be your default printer. Click Next.
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10. Indicate whether you want the printer installed as a shared printer. Click Next.

If you select Shared, you must also enter a Share Name for the printer (or leave the 
default name) and make selections from the list of operating systems used by client 
workstations. For information on shared printers, see the Configuration Guide.

11. Click No in the next dialog box to postpone printing a test page, and click Finish.

When installation is complete, the Printers window appears with an icon for the newly 
installed printer.

TO CONFIGURE INSTALLABLE OPTIONS ON THE FIERY 3850C FROM THE 
POSTSCRIPT PRINTER DRIVER FOR WINDOWS NT 4.0

1. Click the Start button, choose Settings, and then choose Printers.

2. Right-click the Fiery 3850C icon and choose Properties from the File menu.
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3. Click the Device Settings tab, and scroll down to Installable Options. Specify the 

options installed on the Fiery 3850C.

Option Tray—Not Installed, Tray 3, Tray 3 and Tray 4, Tray 3 (LCT)

Finisher Option—Not Installed, 2 Tray Finisher, Mailbox

Duplex Unit—Not Installed, Installed

Punch Option—Not Installed, 2 and 3 holes, 2 and 4 holes, 4 holes

4. Click OK to activate the current settings.

TO CONFIGURE INSTALLABLE OPTIONS ON THE FIERY 3850C FROM THE PCL 
PRINTER DRIVER FOR WINDOWS NT 4.0

1. Click the Start button, choose Settings, and then choose Printers.

2. Right-click the Fiery 3850C icon and choose Document Defaults.

3. Click the Accessories tab.
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4. Select an installed option from the Available Options list, and click Add to move 

the option to the Installed Options list.

Option Tray—Not Installed, Tray 3, Tray 3 and Tray 4, Tray 3 (LCT)

Finisher Option—Not Installed, 2 Tray Finisher, Mailbox

Duplex Unit—Not Installed, Installed

Punch Option—Not Installed, 2 and 3 holes, 2 and 4 holes, 4 holes

5. Click OK.
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Completing the Windows NT 4.0 printer connection

To print from Windows NT 4.0, you need to:

• Set up network servers, if any

• Set up the Fiery 3850C to accept print jobs from your computer

• Configure a port on each Windows NT computer for the network type

Completing the Windows NT 4.0 parallel port connection

The parallel port cable connects the Fiery 3850C to a single computer. Once you have 
installed the Windows NT PostScript printer driver and the Fiery 3850C PPD, 
complete the setup for parallel port printing.

TO SET UP PARALLEL PRINTING FOR WINDOWS NT 4.0

1. Click the Start button, choose Settings, and then choose Printers.

2. Double-click the Fiery 3850C icon and choose Properties from the Printer menu.

In the Ports tab, confirm that LPT1 (Local Port) is checked.

The Fiery 3850C is ready to accept parallel print jobs from your computer, using the 
Windows NT PostScript printer driver and the Fiery 3850C PPD.

3. Click the General tab and click Print Test Page.

When you select print, your files are transmitted over the parallel port connection to 
the Fiery 3850C.

To do this See

Configure the parallel connection “Completing the Windows NT 4.0 parallel port 
connection” below.

Configure the TCP/IP (LPR port) 
connection

“Completing the Windows NT 4.0 TCP/IP and 
LPR connection” on page 27.

Configure the IPX (Novell) connection “Completing the Windows NT 4.0 IPX (Novell) 
connection” on page 29.
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4. Click the Sharing tab if you want to share the Fiery 3850C with network users. Select 

Shared, and select a share name.

Select the operating system or systems used by your network clients if you want to 
install a printer driver that those clients can download.

5. Click OK to exit the Printer Properties dialog box.

Completing the Windows NT 4.0 TCP/IP and LPR connection

Once you have installed the PostScript or PCL printer driver and printer driver files, 
complete the setup for the TCP/IP and LPR connection as follows:

• Prepare the Fiery 3850C to accept print jobs using TCP/IP and LPR protocols. (For 
details, see the Configuration Guide.)

• Configure the workstation for the TCP/IP connection.

Before you continue, ask the system administrator for the IP address assigned to the 
Fiery 3850C, as well as the subnet mask and the gateway address, if they are used.

The TCP/IP Protocol and Microsoft TCP/IP Printing software should already be 
installed on the Windows NT workstation.

TO SET UP TCP/IP AND LPR PRINTING FOR WINDOWS NT 4.0

1. Open the Properties dialog box for the Fiery 3850C, and click the Ports tab.

2. Click Add Port.

The available port types are displayed.
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3. Select LPR Port and click New Port.

If the LPR port is not listed, install the TCP/IP network protocol and Microsoft 
TCP/IP printing software. See the Configuration Guide or your Windows NT 
documentation.

4. Enter the IP address of the Fiery 3850C. 

If your network uses Domain Name Services (DNS), enter the DNS name assigned to 
the Fiery 3850C instead of the IP address.

5. Press Tab and type one of the following names, depending on the Fiery 3850C 

connection you would like to print to.

xjdirect

xjhold

xjprint

NOTE: This name is case-sensitive; type it exactly as shown above.

6. Click OK.

The workstation checks the IP address or DNS name you entered and notifies you if it 
cannot resolve the address.

7. Click Close in the Printer Ports dialog box.

The new port configuration is reflected in the Ports tab. You must now close the 
Printer Properties dialog box to verify the connection. 

8. Click OK to close the Printer Properties dialog box. 

9. Reopen the Printer Properties dialog box.
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10. Click the General tab and click Print Test Page.

When you print, your PostScript or PCL files are transmitted over the LPR Port 
connection to the Fiery 3850C.

11. Click OK to close the Printer Properties dialog box.

Completing the Windows NT 4.0 IPX (Novell) connection

Complete the setup for the IPX (Novell) connection as follows:

• Configure the Novell network and file server for handling Fiery 3850C print jobs. 
The file server should be configured with a print server and print connection for the 
Fiery 3850C. For details, see your NetWare documentation.

• Prepare the Fiery 3850C for IPX printing.

• Set up the IPX connection on the workstation.

NetWare protocols (NWLink IPX/SPX Compatible Transport) and NetWare client 
services should already be installed on the Windows NT workstation.

TO SET UP IPX (NOVELL) PRINTING FOR WINDOWS NT 4.0

1. Double-click Network Neighborhood.

2. Double-click NetWare or Compatible Network.

A list of NetWare servers is displayed.

3. Double-click the NetWare Tree or File Server on which the network administrator 

defined a print connection for the Fiery 3850C.

You may have to log in to the file server to see the print connections.
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4. Double-click the print connection defined for the Fiery 3850C.

5. If the NetWare server does not have a suitable driver for the Fiery 3850C, you may be 

asked if you want to set up the printer on your workstation.

6. Click Yes.

7. Click OK to install the Fiery 3850C PostScript or PCL printer driver (see 

your Windows NT documentation for instructions on how to install printer drivers 

with the Add Printer Wizard).

When installation is complete, a new printer window appears, with the name of the 
print queue on the NetWare server.
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8. Choose Properties from the File menu, and click the Ports tab.

The NetWare queue you just connected to is listed and checked as a port for the 
Fiery 3850C. 

9. Click the General tab and click Print Test Page.

The printer Job Notes window appears. 

10. Enter user and job identification information for accounting purposes, or whatever is 

required at your site, and click OK.

The Fiery 3850C polls the NetWare server for print jobs in the print connection 
defined for the Fiery 3850C. When you print, your PostScript files are spooled to that 
connection and transmitted over the queue “port” to the Fiery 3850C.

The test page job is listed in the queue window until it is printed.
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Setting up SMB printing with Windows NT 4.0

If you do not have a Novell network, you can print via SMB printing (also known as 
Windows printing or WINS printing). Printing by this method allows you to install 
the PostScript or PCL printer driver and printer description files, and print from your 
computer to a particular print connection (Hold, Print, or Direct) on the 
Fiery 3850C. These instructions assume you have the TCP/IP Protocol and Microsoft 
TCP/IP Printing software installed on the Windows NT workstation.

To set up printing to a second or third connection, you must install a new printer by 
repeating the procedure “To set up SMB printing on Window NT 4.0” on page 32. If 
you install more than one printer, give each a descriptive name during printer driver 
installation, such as Aero-Direct, Aero-Print or Aero-Hold, so you can easily identify 
printers.

BEFORE YOU BEGIN

1. Configure the Fiery 3850C for SMB printing in Network Service Setup>SMB Setup.

SMB printing is referred to as Windows Printing in Setup, on the Control Panel Map, 
and on the Configuration page. For more information, see the Configuration Guide.

TO SET UP SMB PRINTING ON WINDOW NT 4.0

1. Double-click the Network Neighborhood icon to display your network environment.
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2. Browse for the printer you would like to print to.

The printer name you are browsing for is the name entered in Network Setup>Service 
Setup>Windows Setup>Server Name. Refer to the Configuration page for this 
information.

The amount of network traffic determines the amount of time required for the Browse 
function.

If you are not able to locate your Fiery 3850C, see your network administrator.

3. Double-click the name of the Fiery 3850C to display enabled print connections.

4. Double-click the name of the connection you want to print to.

The Printers dialog box appears, asking whether you would like to set up the printer.

5. Select Yes to install the PostScript or PCL printer driver and printer description file for 

the selected connection.

The Add Printer Wizard appears.

6. Specify whether you print from MS-DOS based programs, and click Next.

If you choose Yes, you will be prompted to capture a printer port before proceeding 
with the installation. See your Windows documentation for details.

7. In the dialog box displaying lists of manufacturers and printers, click Have Disk.

The Install from Disk dialog box prompts you for the disk.
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8. If you are installing from the CD, type the name of the CD-ROM drive (for example, 

D:\), and click Browse. Browse to the appropriate folder.

To install the PostScript driver, browse to English\Prntdrvr\Ps_drvr\Win_NT 4x.

To install the PCL driver, browse to English\Prntdrvr\Pcl_drvr\Win_NT 4x.

Make sure “Oemsetup.inf” or “Oemsetup” is selected.

The path is copied to the Install from Disk dialog box.

9. Verify the path is correct, and click OK.

10. In the Printers box, select the Fiery 3850C PS or PCL file and click Next.

11. Enter a name for the Fiery 3850C (or leave the default name) in the Printer name box, 

and choose whether you want the Fiery 3850C to be your default printer. Click Next.

12. Indicate whether you want the printer installed as a shared printer. Click Next.

13. You are asked if you would like to print a test page. Choose Yes and click Finish.

The necessary files are installed to your hard disk.

If the test page prints successfully, you are ready to print from the computer.

Setting up PostScript or PCL printing with 
Windows 2000
To set up the Fiery 3850C as a PostScript or PCL printer, you must install the 
PostScript or PCL Printer Driver for Windows 2000 and its corresponding printer 
description files. You must have Windows 2000 with Service Pack 2 installed. You 
must also configure a particular type of print connection between the workstation and 
the Fiery 3850C. If you are printing over a network, you will need to configure a 
network connection; if you are printing directly to the printer, you will need to 
configure a parallel port connection.

If AutoRun is enabled on your computer, the installer runs automatically when the 
User Software CD is inserted in the CD-ROM drive. You can specify which files to 
install on your computer. 

NOTE: If AutoRun is not enabled, you can run the installer by double-clicking the 
CD-ROM drive icon in My Computer, or by double-clicking the Setup.exe file in the 
Installr folder on the User Software CD.
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The instructions below describe installing a printer locally. Adding a printer to a local 
system requires that you log in to your local Windows 2000 workstation (not the 
network server domain) and that you be a member of the Administrators group. The 
procedure for adding a network printer is similar to adding a port. This procedure is 
described in “Completing the Windows 2000 TCP/IP and LPR connection” on 
page 41.

The procedure below describes installing the printer drivers from the User 
Software CD. The procedures that follow describe setting up the print connection.

TO INSTALL THE POSTSCRIPT OR PCL PRINTER DRIVER USING 
AUTORUN OR INSTALLER

1. Insert the User Software CD in your CD-ROM drive.

2. Follow the instructions on screen.

3. Choose from the Typical, Compact, or Custom installation options.

TO INSTALL THE POSTSCRIPT OR PCL PRINTER DRIVER FOR WINDOWS 2000 USING 
THE ADD PRINTER WIZARD

1. Click Start, choose Settings, and then choose Printers to display the Printers window.

2. Double-click the Add Printer icon, and click Next.

Choose this To install

Typical The PostScript printer driver and printer description 
files for the Fiery 3850C and the PCL printer driver and 
printer description files for the Fiery 3850C.

Compact Installs the PostScript printer driver and printer 
description files.

Custom Installs the files you select. You can select from the 
following:
PostScript printer driver and printer description files
PCL printer and printer description files
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3. Specify whether you are printing using a Local printer, and click Next.

This procedure describes installing a printer locally. You can modify the connection 
later, according to your network type.

4. Select the LPT1 port and click Next.

You will configure the port later, according to your network type.

5. In the dialog box displaying lists of manufacturers and printers, click Have Disk.
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The Install from Disk dialog box prompts you for the disk.

6. Type the name of the CD-ROM drive (for example, D:\), and click Browse. 

Browse to English\Prntdrvr\Pcl_drvr\Win_2000 or English\Prntdrvr\Ps_drvr\ 
Win_2000.

Make sure “Oemsetup” or “Oemsetup.inf” is selected.

The path is copied to the Install From Disk dialog box.

7. Verify the path is correct, and click OK.

8. In the Printers box, select the Fiery 3850C PS or PCL file and click Next.

9. Enter a name for the Fiery 3850C (or leave the default name) in the Printer Name box.

This name will be used in the Printers and queue windows.
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10. If you want the Fiery 3850C to be the default printer, select Yes; if not, select No. 

Click Next.

11. Indicate whether you want the printer installed as a shared printer. Click Next.

If you select Share as, you must also enter a Share Name for the printer (or leave the 
default name) and make selections from the list of operating systems used by client 
workstations. Refer to the Configuration Guide and the corresponding documentation 
for more information on shared printers.

12. Select No to printing a test page and click Next.

You will print the test page after you finish configuring the printer.

13. Verify the printer settings specified and click Finish.

14. Click Yes to complete installation.

The necessary files are installed on your hard disk.

NOTE: The Digital Signature Not Found window may appear, indicating that the 
printer driver for Windows 2000 does not have a Microsoft digital signature; however, 
printing to the Fiery 3850C is processed correctly.

If this is the first printer driver you are installing on the computer, you are prompted to 
install files from the Windows 2000 CD. 
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15. Insert the CD-ROM, browse to the win2000\english\i386 folder, and then click OK.

When installation is complete, the Printers window appears with an icon for the newly 
installed printer.

TO CONFIGURE INSTALLABLE OPTIONS ON THE FIERY 3850C FROM THE 
POSTSCRIPT PRINTER DRIVER FOR WINDOWS 2000

1. Click the Start button, choose Settings, and then choose Printers.

2. Right-click the Fiery 3850C icon, and choose Properties.

3. Click the Accessories tab. 

4. Select an installable option and click Add to move the option to the Installed Options 

list.

Option Tray—Not Installed, Tray 3, Tray 3 and Tray 4, Tray 3 (LCT)

Finisher Option—Not Installed, 2 Tray Finisher, Mailbox

Duplex Unit—Not Installed, Installed

Punch Option—Not Installed, 2 and 3 holes, 2 and 4 holes, 4 holes

5. Click OK.

TO CONFIGURE INSTALLABLE OPTIONS ON THE FIERY 3850C FROM THE PCL 
PRINTER DRIVER FOR WINDOWS 2000

1. Click the Start button, choose Settings, and then choose Printers.

2. Right-click the Fiery 3850C icon, and choose Printing Preferences.

3. Click Accessories. Select an installed option from the Available Options list, and click 

Add to move the option to the Installed Options list.

4. Click OK.
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Completing the Windows 2000 printer connection

To print from Windows 2000, you need to:

• Set up network servers, if any

• Set up the Fiery 3850C to accept print jobs from your computer

• Configure a port on each Windows 2000 computer for the network type

Completing the Windows 2000 parallel port connection

The parallel port cable connects the Fiery 3850C to a single computer. Once you have 
installed the Windows 2000 printer driver and the Fiery 3850C PPD, complete the 
setup for parallel port printing.

TO SET UP PARALLEL PRINTING FOR WINDOWS 2000

1. Click the Start button, choose Settings, and then choose Printers.

2. Click the Fiery 3850C icon, and choose Properties from the File menu.

In the Ports tab, confirm that LPT1 (Local Port) is checked. The Fiery 3850C is ready 
to accept parallel print jobs from your computer, using the Windows 2000 printer 
driver and the Fiery 3850C PPD.

3. Click the General tab and click Print Test Page.

When you select print, your files are transmitted over the parallel port connection to 
the Fiery 3850C.

To do this See

Configure the parallel connection “Completing the Windows 2000 parallel port 
connection” below.

Configure the TCP/IP (LPR port) 
connection

“Completing the Windows 2000 TCP/IP and 
LPR connection” on page 41.

Configure the IPX (Novell) connection “Completing the Windows 2000 IPX (Novell) 
connection” on page 43.
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4. Click the Sharing tab if you want to share the Fiery 3850C with network users. Select 

Shared, and select a share name.

Select the operating system or systems used by your network clients if you want to 
install a printer driver that those clients can download.

5. Click OK to exit the Printer Properties dialog box.

Completing the Windows 2000 TCP/IP and LPR connection

Once you have installed the PostScript or PCL printer driver and printer driver files, 
complete the setup for the TCP/IP and LPR connection as follows:

• Prepare the Fiery 3850C to accept print jobs using TCP/IP and LPR protocols. (For 
details, see the Configuration Guide.)

• Configure the workstation for the TCP/IP connection.

Before you continue, ask the system administrator for the IP address assigned to the 
Fiery 3850C, as well as the subnet mask and the gateway address, if they are used.

The TCP/IP Protocol and Microsoft TCP/IP Printing software should already be 
installed on the Windows 2000 workstation.

NOTE: The following procedure for PostScript and PCL printer drivers are similar. 
PostScript screen captures are used with PCL differences noted.

TO SET UP TCP/IP AND LPR PRINTING FOR WINDOWS 2000

1. Open the Properties dialog box for the Fiery 3850C, and click the Ports tab.

2. Click Add Port.

The available port types are displayed.
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3. Select LPR Port and click New Port.

If the LPR port is not listed, install the TCP/IP network protocol and Microsoft 
TCP/IP printing software. See the Configuration Guide or your Windows 2000 
documentation.

4. Enter the IP address of the Fiery 3850C. 

If your network uses Domain Name Services (DNS), enter the DNS name assigned to 
the Fiery 3850C instead of the IP address.

5. Press Tab and type one of the following names, depending on the Fiery 3850C 

connection you would like to print to.

xjdirect

xjhold

xjprint

NOTE: This name is case-sensitive; type it exactly as shown above.

6. Click OK.

The workstation checks the address or DNS name you entered and notifies you if it 
cannot resolve the address.

7. Click Close in the Printer Ports dialog box.

The new port configuration is reflected in the Ports tab. You must now close the 
Printer Properties dialog box to verify the connection. 

8. Click OK to close the Printer Properties dialog box. 

9. Reopen the Printer Properties dialog box.

10. Click the General tab and click Print Test Page.

When you print, your PostScript or PCL files are transmitted over the LPR Port 
connection to the Fiery 3850C.
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11. Click OK to close the Printer Properties dialog box.

Completing the Windows 2000 IPX (Novell) connection

Complete the setup for the IPX (Novell) connection as follows:

• Configure the Novell network and file server for handling Fiery 3850C print jobs. 
The file server should be configured with a print server and print connection for the 
Fiery 3850C. For details, see your NetWare documentation.

• Prepare the Fiery 3850C for IPX printing.

• Set up the IPX connection on the workstation.

NetWare protocols (NWLink IPX/SPX Compatible Transport) and NetWare client 
services should already be installed on the Windows 2000 workstation.

TO SET UP IPX (NOVELL) PRINTING FOR WINDOWS 2000

1. Double-click My Network Places.

2. Double-click NetWare or Compatible Network.

A list of NetWare servers is displayed.
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3. Double-click the NetWare Tree or File Server on which the network administrator 

defined a print connection for the Fiery 3850C.

You may have to log in to the file server to see the print connections.

4. Double-click the print connection defined for the Fiery 3850C.

5. If the NetWare server does not have a suitable driver for the Fiery 3850C, you may be 

asked if you want to set up the printer on your workstation.

6. Click Yes.

7. Click OK to install the Fiery 3850C PostScript or PCL printer driver (see your 

Windows 2000 documentation for instructions on how to install printer drivers with 

the Add Printer Wizard).

When installation is complete, a new printer window appears, with the name of the 
print queue on the NetWare server.
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8. Choose Properties from the File menu, and then click the Ports tab.

The NetWare queue you just connected to is listed and checked as a port for the 
Fiery 3850C. 

9. Click the General tab and click Print Test Page.

The printer Job Notes window appears. 

10. Enter user and job identification information for accounting purposes, or whatever is 

required at your site, and click OK.

The Fiery 3850C polls the NetWare server for print jobs in the print connection 
defined for the Fiery 3850C. When you print, your PostScript files are spooled to that 
connection and transmitted over the queue “port” to the Fiery 3850C.

The test page job is listed in the queue window until it is printed.
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Setting up SMB printing on Windows 2000

If you do not have a Novell network, you can print via SMB printing (also known as 
Windows printing or WINS printing). Printing by this method allows you to install 
the PostScript or PCL printer driver and printer description files, and print from your 
computer to a particular print connection (Hold, Print, or Direct) on the 
Fiery 3850C. These instructions assume you have the TCP/IP Protocol and Microsoft 
TCP/IP Printing software installed on the Windows 2000 workstation.

To set up printing to a second or third connection, you must install a new printer by 
repeating the procedure “To set up SMB printing on Windows 2000” on page 47. If 
you install more than one printer, give each a descriptive name during printer driver 
installation, such as Aero-Print or Aero-Hold, so you can easily identify printers.

NOTE: With Windows 2000, you cannot install the driver and configure the printing 
connection to the Fiery 3850C in a single procedure. The printer driver needs to be 
installed from the User Software CD. Refer to your Windows documentation for more 
details.

BEFORE YOU BEGIN

1. Configure the Fiery 3850C for SMB printing in Network Service Setup>SMB Setup.

SMB printing is referred to as Windows Printing in Setup, on the Control Panel Map, 
and on the Configuration page. For more information, see the Configuration Guide.

2. Install the PS or PCL printer driver (see “To install the PostScript or PCL printer driver 

for Windows 2000 using the Add Printer Wizard” on page 35).
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TO SET UP SMB PRINTING ON WINDOWS 2000

1. Double-click My Network Places.

2. Browse for the printer you would like to print to.

The printer name you are browsing for is the name entered in Network Setup>
Service Setup>SMB Setup>Server Name. Refer to the Configuration page
for this information.

The amount of network traffic determines the amount of time required for the Browse 
function.

If you are not able to locate your Fiery 3850C, see your network administrator.
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3. Double-click the name of the Fiery 3850C to display enabled print connections.

4. Double-click the name of the connection you want to print to.

The Printers dialog box appears, asking whether you would like to set up the printer.

5. Select Yes to install the PostScript or PCL printer driver and printer description file for 

the selected connection.

The Add Printer Wizard appears.

6. Specify whether you print from MS-DOS based programs, and click Next.

If you choose Yes, you will be prompted to capture a printer port before proceeding 
with the installation. See you Windows documentation for details.

Complete the instructions for installing the printer driver and printer description file 
starting with step 5 on page 36.
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7. Enter a name for the Fiery 3850C (or leave the default name) in the Printer name box, 

and choose whether you want the Fiery 3850C to be your default printer. Click Next.

Installing Fiery 3850C software
The User Software CD includes the software installer for ColorWise Pro Tools. Fiery 
utility software must be separately installed on each user’s computer.

ColorWise Pro Tools

The ColorWise Pro Tools software installer is located on the User Software CD. Before 
you begin this installation, determine the following:

• Where do you want to install the software on your hard disk?

By default, the installer places ColorWise Pro Tools software in the Programs\Fiery 

folder on your hard disk.

• What do you want to name the ColorWise Pro Tools folder in the 
Windows\Start Menu\Programs folder?

By default, the installer names the folder “ColorWise Pro Tools.”
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TO INSTALL COLORWISE PRO TOOLS SOFTWARE

1. On the User Software CD, double-click to open the ColorWise Pro folder.

2. Double-click the Setup.exe icon.

For specific instructions, read the information in each dialog box. 

Using the software for the first time
Before you can use the newly installed software, you must properly configure the 
connection to the Fiery 3850C.

Configuring the connection for Fiery utilities 

The first time you launch one of the Fiery utilities, you are prompted to configure the 
connection to the Fiery 3850C. The same configuration is used for all Fiery utilities, so 
any change in one configuration affects all the other connections.

BEFORE YOU BEGIN

• Print the Configuration page from the Control Panel and note the IP address of the 

Fiery 3850C. 

You can also set up a Domain Name Server (DNS) for the IP address of the 
Fiery 3850C. See your Windows system documentation for information.

TO CONFIGURE THE CONNECTION FOR FIERY UTILITIES

1. Start the utility for which you want to configure a connection.

2. If the No Servers Configured dialog box appears, click OK.
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3. Enter the appropriate information for the Fiery 3850C.

Nickname—Enter a name for the Fiery 3850C. This name can be any name you wish; 
it does not have to match the actual Server Name of the Fiery 3850C.

NOTE: The nickname cannot contain any of the following seven characters:
[ ] _ " ' <space> <tab>

Protocol—Choose the type of network protocol you are using from the pop-up menu.

NOTE: Fiery utilities for the Fiery 3850C are not supported over IPX/SPX. Command 
WorkStation software is supported on Windows computers over TCP/IP.

Server Name—Enter the IP address (or DNS name) of the Fiery 3850C. 

New Device—Enter 3850C, the device name for the Fiery 3850C.

4. When you have entered all the information, click Add to add the Fiery 3850C to the 

Devices list.

5. With the device name (3850C) selected in the Devices list, click OK.

For TCP/IP networks
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The Fiery 3850C appears in the list of Available servers. The first line of the entry 
displays the nickname you gave the server, followed by the protocol you chose. The 
second line displays the device name. 

6. With the device name (3850C) selected in the list of Available servers, click OK to 

begin using the utility.

Modifying the configuration

You should edit the configuration whenever there is any change to your Fiery 3850C 
server or network, such as a server name or IP address. Change the specific 
Fiery 3850C Setup information before configuring the connection.

TO MODIFY THE CONFIGURATION

1. To edit information for a Fiery 3850C in the list of Available servers, select the 

Fiery 3850C by its nickname and click Modify. 

2. Edit information in the Modify Server Settings dialog box as necessary, and click OK 

when finished.

3. To add a new Fiery 3850C to the list of Available servers, click Add. Configure the Add 

New Server dialog box as outlined in steps 3 through 5 in the previous procedure.

4. To remove a Fiery 3850C, select the Fiery 3850C by its nickname, and click Remove.

NOTE: The nickname cannot be modified.

Device Name of the Fiery 3850C 
(3850C)
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Copying color files from the User Software CD
You can copy additional color files from the User Software CD to your hard disk.  

Icm folder ICM monitor setting file and a device profile specially designed 
for use with the Fiery 3850C and particular copier models. For 
instructions on installing see “Installing the ICM profiles on a 
Windows computer” on page 54.

Clrfiles folder 
(inside English 
folder)

Cmyk.ps, an 11-page, PostScript file to use for reference when 
defining CMYK colors in applications.
Pantone.ps, a 19-page, PostScript file that indicates the closest 
equivalent of PANTONE coated colors that the Fiery 3850C 
and your copier model can produce. The method used to print 
the Pantone.ps file differs depending on the Spot Color 
Matching setting. For more information, see the Printing Guide 
and the Color Guide.
Rgb_01.doc, a file you can print from Microsoft Word 97 or 
later to view available RGB colors.
Rgb_02.ppt, a file you can print from PowerPoint 6.0 or later to 
view available RGB colors.

Calibrat folder
(inside English/ 
Clrfiles folder)

Four PostScript files of color patches for obtaining 
measurements: Custom21.ps, Custom34.ps, Stand21.ps, and 
Stand34.ps. 
The numbers in the filenames refer to the number of patches on 
the page. The Custom files allow you to download measurement 
patches that incorporate the copier’s current calibration set. The 
Standard files allow you to download standard measurement 
patches that bypass the copier’s current calibration set. For 
information on how to use these files, see the Color Guide.

NOTE: These files are provided for expert users and should not be 
used for day-to-day calibration.
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Installing the printer description files for Windows
The User Software CD contains printer description files for popular Windows 
applications. PageMaker 5.0, 6.0, 6.5, and 7.x do not support automatic installation of 
printer description files from the Printers Control Panel. To make the Fiery 3850C 
available in the Print and Page Setup dialog boxes of this application, copy printer 
description files to the appropriate location.

TO COPY THE PRINTER DESCRIPTION FILES

1. On the User Software CD, open the PageMaker folder.

2.  Copy the printer description file for your Fiery 3850C to the appropriate location.

Installing the ICM profiles on a Windows computer

The ICM profiles included in the Icm folder on the User Software CD are for use 
with ColorWise Pro Tools. You can also use the ICM profiles with applications that 
support ICC standards, such as Photoshop. For most ICC aware applications, the files 
must be installed into a folder named Color in the System folder. For use with 
ColorWise Pro Tools, you can copy the files to a folder of your choice. 

 For more information on using ICC profiles with ColorWise Pro Tools, see the Color 

Guide.

If you use Copy this file To this location

PageMaker 5.0 or later EFDR60PM.ppd For PageMaker 5.0, 
\ALDUS\USENGLSH\PPD4
For PageMaker 6.0, 
\PM6\RSRC\USENGLSH\PPD4
For PageMaker 6.5, 
\PM65\RSRC\USENGLSH\PPD4
For PageMaker 7.x,
\PM7\RSRC\USENGLSH\PPD4
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TO INSTALL THE ICM PROFILES ON A WINDOWS COMPUTER

1. On the User Software CD, open the Icm folder.

2. If you are using Windows 9x/Me, copy the profiles to the Windows\System\Color folder 

on your hard disk.

If you are using Windows NT or Windows 2000/XP, copy the profiles to the 

Winnt\System32\Color folder on your hard disk.

NOTE: If a folder named “Color” does not exist in the Sytem32 folder, create one and 
install the profiles into it.

Loading the monitor settings file

The Efirgb.icm monitor settings file can be used in Photoshop, or other applications 
that support ICM profiles, to define a source color space for printing to the 
Fiery 3850C.

These instructions assume you have installed the ICM profiles included on the 
User Software CD. For more information, see “Copying color files from the 
User Software CD” on page 53.

NOTE: The internal name of an ICC profile may vary slightly from its file name.

TO LOAD THE RGB WORKING SPACE PROFILE FOR PHOTOSHOP 5.X

1. Launch Photoshop.

2. From the File menu, choose Color Settings, and from the Color Settings submenu, 

choose RGB Setup.
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3. In the RGB Setup dialog box, click Load.

4. For Windows 9X/Me, browse to the Windows\System\Color, select Efirgb.icm, and click 

Load.

For Windows NT 4.0 and Windows 2000/XP, browse to the Winnt\System32\Color 

folder, select Efirgb.icm, and click Load.

The Efirgb v1f file appears as the selection in the RGB pop-up menu of the RGB Setup 
dialog box.

5. Click OK.

For more information about ICM profiles, see your application’s documentation.
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Loading the ICM copier device profile

This ICM profile defines the target color space for printing to the copier.

These instructions assume you have installed the ICM profiles included on the 
User Software CD. For more information, see “Installing the ICM profiles on a 
Windows computer” on page 54.

NOTE: The internal name of an ICC profile may vary slightly from its filename.

TO LOAD THE ICM COPIER DEVICE PROFILE IN PHOTOSHOP 
5.X

1. Launch Photoshop.

2. From the File menu, choose Color Settings, and from the Color Settings submenu, 

choose CMYK Setup.

3. In the CMYK Setup dialog box, choose ICC as the CMYK color model.

4. Select the profile that corresponds to the Fiery 3850C from the Profile pop-up menu.

5. Click OK.

For more information about ICC profiles, see your application’s documentation.
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Loading monitor settings files and ICM device profiles in 
Photoshop 6.x

Once you have installed the Efirgb.icm monitor settings file and the ICM device 
profile for the Fiery 3850C, they can be loaded at the same time in Photoshop 6.x.

TO LOAD THE MONITOR SETTINGS FILE AND ICM DEVICE PROFILE IN 
PHOTOSHOP 6.X

1. Start Photoshop.

2. Choose Color Settings from the Edit menu, and select Advanced Mode in the Color 

Settings dialog box.

3. Choose EFI RGB v1f from the RGB menu.

4. Choose the profile that corresponds to the Fiery 3850C from the CMYK menu.

5. Click OK.

For more information, see your application’s documentation.
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The general steps for installing the Fiery 3850C user software and setting up printing 
on a Mac OS computer are:

• Install the Adobe PostScript printer driver and PostScript Printer Description file 
(PPD).

• Set up the Fiery 3850C in the Chooser.

• Install ColorWise Pro Tools.

• Install the printer and screen fonts.

• Copy additional application-specific files from the User Software CD as needed.

Installing Mac OS software
The User Software CD contains the following installers:

• Printer Driver—Adobe PostScript printer driver and PPD installer

• ColorWise Pro Tools

• Fonts

Setting up the Fiery 3850C as a PostScript printer
To set up the Fiery 3850C as a PostScript printer, you must install the Adobe 
PostScript printer driver and the PPD file that corresponds to your printer. The 
Adobe PostScript printer driver and PPD files are provided on the User Software CD.

Printer drivers provide a way to communicate information on print jobs between your 
applications, the Fiery 3850C, and any other PostScript printer connected to your 
computer. You can use the following procedures 

TO INSTALL THE ADOBEPS PRINTER DRIVER AND PPD FILE

1. Open the English: Printer Driver folder.

2. Double-click the AdobePS 8.7.2 Installer icon.

Installing 
User Software 
on a Mac OS 
Computer
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A warning dialog box appears.

3. Click Yes to continue with installation of printer driver software, and to confirm that 

your computer must be restarted after installation.

The AdobePS Installer installs the Adobe PostScript printer driver and the PPD file 
that corresponds to your printer.

4. Click Restart when installation is complete.

NOTE: If you operate the Fiery 3850C in a copy shop, quick print shop, or service 
bureau, you might want to provide copies of the printer driver or PPD file used in 
conjunction with the image and relevant documentation to customers. This ensures 
that jobs they create and print to files are properly formatted for printing to the 
Fiery 3850C.

Setting up the Fiery 3850C in the Chooser

After you install the Adobe PostScript printer driver and PPD file (see “Setting up the 
Fiery 3850C as a PostScript printer” on page 59), you need to set up the Fiery 3850C 
in the Chooser in order to take full advantage of its features. This section describes how 
to set up the Fiery 3850C with the AdobePS printer driver.

TO SET UP THE FIERY 3850C IN THE CHOOSER

1. Select Chooser from the Apple menu.

Make sure AppleTalk is set to Active.

2. Select the correct AppleTalk Zone, if necessary.
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3. Click the AdobePS icon.

The Fiery 3850C appears in the Select a PostScript Printer list in the form of <server 
name>_<device name>_<print connection>. The device name (3850C) is the internal 
name of your printer. 

NOTE: Only the print connections (Direct, Hold, and Print) that have been enabled in 
Setup appear in the Chooser. 

4. Select a Fiery 3850C connection from the “Select a PostScript Printer” list, and 

click Create.

The AdobePS printer driver automatically selects the correct PPD file for your 
Fiery 3850C.

NOTE: You will need to set up each print connection separately. Repeat step 4 for all 
enabled connections.

5. In the Chooser list, select the icon that appears next to the newly installed 

Fiery 3850C, and click Setup.
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6. Click Configure in the dialog box that appears.

7. In the Installable Options dialog box, select the appropriate settings from the 

pop-up menus, and click OK.

Option Tray—Not Installed, Tray 3, Tray 3 and Tray 4, Tray 3 (LCT)

Finisher Option—Not Installed, 2 Tray Finisher, Mailbox

Duplex Unit—Not Installed, Installed

Punch Option—Not Installed, 2 and 3 holes, 2 and 4 holes, 4 holes

8. Close the Chooser.

Installing Fiery 3850C software and fonts
The Mac OS installers function essentially the same for each type of software. Before 
you begin each installation, determine where you want to install each item on your 
hard disk. By default, the installers place:

• ColorWise Pro Tools in a folder named “Fiery f ” on the top level of your hard disk.

• Fonts in the System folder:Fonts folder on your hard disk.

For instructions on installing fonts, see “Fonts” on page 67.
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TO INSTALL MAC OS SOFTWARE

1. On the User Software CD, double-click the Installer icon of the item you would like to 

install.

2. Read the Software License Agreement, and click Accept.

3. Click Install to copy the item to the default location, or navigate to a location in 

which to install the item.

Use the table below as a guide when installing software.

4. If prompted, click Quit to close the software installer.

In order to use ColorWise Pro Tools, you must have Mac OS Runtime for Java (MRJ 
2.2.4) installed on your computer.

If you do not have MRJ installed, the ColorWise Pro Tools installer automatically 
initiates the MRJ 2.2.4 installation process. 

If you are installing Action To install

ColorWise Pro Tools Specify a hard disk location for ColorWise Pro 
Tools software.

Click 
Install.
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TO INSTALL MAC OS RUNTIME FOR JAVA

1. Read the Apple Computer Inc., License agreement and click Agree to install the 

software.

2. Click Install.

Some files are installed.

3. Click Quit.

Using the software for the first time
Before you can use the newly installed software, you must properly configure the 
connection to the Fiery 3850C.

Configuring a connection for ColorWise Pro Tools

The first time you use ColorWise Pro Tools, you are prompted to configure a 
connection to the Fiery 3850C.

NOTE: ColorWise Pro Tools function only over TCP/IP networks. 

BEFORE YOU BEGIN

• Print the Configuration page from the Control Panel and note the IP address of 

the Fiery 3850C.
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TO CONFIGURE A CONNECTION FOR COLORWISE PRO TOOLS

1. Launch the utility by double-clicking its icon.

The Choose Printer Device dialog box appears.

2. If you have previously configured a connection to the Fiery 3850C, then you are 

ready to use ColorWise Pro Tools. If you have not configured a connection, click 

Add.

3. Enter the appropriate information for the Fiery 3850C.

Nickname—Enter a name for the Fiery 3850C. This can be any name you wish; it 
does not have to match the actual server name of the Fiery 3850C.

NOTE: The nickname cannot contain any of the following seven characters:
[ ] _ " ' <space> <tab>

Protocol—Choose the type of network protocol you are using from the pop-up menu. 
ColorWise Pro Tools is supported only with TCP/IP, so no selection is necessary.



66 Installing User Software on a Mac OS Computer

Server Name—Enter the IP address (or DNS or hosts name) of the Fiery 3850C.

New Device—Enter the name of the device the Fiery 3850C is connected to: 3850C. 
This device name appears in the Printer Setup section of the Configuration page.

4. When you have added all the information, click Add.

5. With the device name (3850C) selected in the Devices list, click OK.

The Fiery 3850C appears in the list of available servers. The first line of the entry 
displays the nickname you gave the server, followed by the protocol. The second line 
displays the device name.

6. With the device name (3850C) selected in the list of Available Servers, click 

Select to begin using ColorWise Pro Tools.

Modifying the configuration

You should edit the configuration whenever there is any change in your original 
configuration, such as a change of IP address. Change the specific Fiery 3850C Setup 
information before configuring the connection. 

Device name of the Fiery 3850C 
(3850C)
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TO MODIFY THE CONFIGURATION

1. To edit information for a Fiery 3850C in the list of available servers, select the 

Fiery 3850C by its nickname and click Modify. Edit information in the Modify 

Server Settings dialog box as necessary, and click OK when finished.

2. To add a new Fiery 3850C to the list of available servers, click Add. Configure the 

Add New Server dialog box as outlined in steps 3 through step 5 in the previous 

procedure.

3. To remove a Fiery 3850C from the list of available servers, select the Fiery 3850C 

by its nickname and click Remove.

Fonts

The fonts on the User Software CD include screen and printer fonts that correspond 
to the 136 built-in PostScript printer fonts on the Fiery 3850C. The Font installer 
copies both kinds of fonts to the System folder:Fonts folder on your hard disk. To be 
available to applications, the screen fonts must remain in the System:Fonts folder. The 
printer fonts can be copied to a folder of your choice. 

NOTE: In the System:Fonts folder, when displayed by Kind, screen fonts appear as type 
“Font Suitcase” and PostScript printer fonts appear as type “PostScript™ font.”

TO INSTALL SCREEN AND PRINTER FONTS

1. On the User Software CD, double-click the Fonts icon to launch the Fonts 

installer. 

2. Click Install.

By default, the fonts are installed to the System folder:Fonts folder on your hard disk.

If you have any applications open, you must quit and relaunch them before the newly 
installed screen fonts are available.
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Copying color files from the User Software CD
You can copy additional color files from the User Software CD to your hard disk.

The User Software CD contains the following color files:

ColorSync files 
(inside the 
ColorSync 
Folder)

If you are using ColorSync 2.5 or later, install the profiles into 
the ColorSync Profiles folder inside the System folder. If you are 
using an earlier version of ColorSync, install the profiles to the 
ColorSync Profiles folder inside the System:Preferences folder. 
The printer profile can be moved to a folder of your choice.

Color Files 
folder (inside 
the English 
folder)

CMYK Color Reference.ps, an 11-page, letter-size PostScript file 
to use for reference when defining CMYK colors in applications.
PANTONE Book.ps, a 19-page, letter-size PostScript file that 
indicates the closest equivalent of PANTONE coated colors that 
the Fiery 3850C and your particular printer model can produce. 
The method used to print the PANTONE Book.ps file differs 
depending on the Spot Color Matching setting. For more 
information, see the Printing Guide and the Color Guide. 
RGB page 01, a file you can print from Microsoft Word 97 or 
later to view available RGB colors.
RGB page 02, a file you can print from PowerPoint 6.0 or later 
to view available RGB colors.

Calibration 
folder
(inside Color 
Files folder)

Four PostScript measurements files of color patches: 
custom21.ps, custom34.ps, standard21.ps and standard34.ps. 
The numbers in the filenames refer to the number of patches on 
the page. The Custom files are provided to enable you to 
download measurement patches that incorporate the copier’s 
current calibration set. The Standard files are provided to enable 
you to download standard measurement patches that bypass the 
printer’s current calibration set. For information on how to use 
these files, see the Color Guide.

These files are provided for expert users and should not be used 
for day-to-day calibration.
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Loading ICC profiles

The ICC profiles installed by the ColorSync installer are for use with ColorWise Pro 
Tools and applications that support ICC standards. 

These instructions assume that you have already installed the ICC profiles included on 
the User Software CD. For more information, see “Copying color files from the 
User Software CD” on page 68.

NOTE: The internal name of an ICC profile may vary slightly from its filename.

The following procedure describes installing the ICC profiles with ColorSync 4.0. 
For more information about ColorSync, see your application’s documentation.

TO SET THE COLORSYNC SYSTEM PROFILE

1. Choose Control Panels>ColorSync from the Apple Menu.

2. Select EFIRGB v1f from the System Profile list.

When selected as the ColorSync system profile, EFIRGB v1f sets the optimal source 
color space for printing to the Fiery 3850C. The color space set by the EFIRGB v1f 
profile is the same as that set by the EFIRGB setting of the RGB Source Profile print 
option. 

NOTE: The RGB Source Profile print option setting overrides the ColorSync system 
profile setting. 
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3. Close the ColorSync window.

For more information about ICC profiles, see your application’s documentation.

Loading the monitor settings file

The EFIRGB ICC monitor settings file can be used in Photoshop, or other 
applications that support ICC profiles to define a source color space for printing to the 
Fiery 3850C.

TO LOAD THE MONITOR SETTINGS FILE IN PHOTOSHOP 5.X

1. Launch Photoshop.

2. From the File menu, choose Color Settings, and from the Color Settings submenu, 

choose RGB Setup.

3. In the RGB Setup dialog box, click Load.

4. Browse to the System: Preferences: ColorSync Profiles, select the EFIRGB ICC file, 

and click Open.

NOTE: If you are using ColorSync 2.5 or later, the ColorSync profiles are is located in 
System Folder:ColorSync Profiles.

The EFIRGB ICCv1f file appears as the selection in the RGB pop-up menu of the 
RGB Setup dialog box.

5. Click OK.
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Loading the ICC printer profile

The ICC printer profile enables RGB-to-CMYK conversions that are specific to the 
kind of printer you are using. 

TO LOAD THE ICC PRINTER PROFILE IN PHOTOSHOP 5.X

1. Launch Photoshop.

2. From the File menu, choose Color Settings, and from the Color Settings submenu, 

choose CMYK Setup.

3. In the CMYK Setup dialog box, choose ICC as the CMYK color model.

4. Select the profile that corresponds to the Fiery 3850C from the Profile pop-up 

menu.

5. Click OK.

For more information about ICC profiles, see your application’s documentation.
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Loading the monitor settings file and the ICC device profile in 
Photoshop 6.x

In Photoshop 6.x, you can load the monitor settings file and the ICC device profile at 
the same time.

TO LOAD THE MONITOR SETTINGS FILE AND THE ICC DEVICE PROFILE IN 
PHOTOSHOP 6.X

1. Start Photoshop.

2. Choose Color Settings from the Edit menu and then choose Advanced Mode.

3. Choose EFI RGB v1F from the RGB menu.

4. Select the profile that corresponds to the Fiery 3850C from the CMYK menu.

5. Click OK.

For more information, see your Photoshop documentation.
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Fiery WebTools allow you to manage your Fiery 3850C remotely from the Internet or 
from your company’s intranet. The Fiery 3850C has its own home page, from which 
you are able to select from a variety of functions including Status, WebSpooler, 
WebSetup, WebLink, and WebDownloader.

For more information on using Fiery WebTools, see the Printing Guide and the Job 

Management Guide.

Setting up Fiery WebTools
In order for network users to access and use Fiery WebTools, you need to set certain 
Fiery 3850C options in Network Setup and Printer Setup. You also need to prepare 
each user’s workstation to communicate with the Fiery 3850C over the Internet or 
intranet.

For more information about Network Setup, see the Configuration Guide.

 Fiery WebTools
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TO SET UP FIERY WEBTOOLS ON THE FIERY 3850C

1. In Fiery 3850C Network Setup, enable TCP/IP.

2. Set a valid, unique IP address for the Fiery 3850C, and then set the subnet mask. 

Set a gateway address if necessary.

3. In Fiery 3850C Printer Setup, confirm the Print Queue is published.

TO SET UP CLIENT WORKSTATIONS TO USE FIERY WEBTOOLS

1. Enable TCP/IP networking.

2. Make sure the workstation has a valid, unique IP address.

3. Make sure the workstation is installed with one of the following Internet 

browsers:

Windows 9x/Me, Windows NT 4.0, and Windows 2000—Either Netscape 
Communicator v4.7 or later or Microsoft Internet Explorer v5.5 and SP2 or later.

Windows XP—Either Netscape Communicator v6.0 or Microsoft Internet Explorer 
v6.0.

Mac OS—Either Netscape Communicator v4.7 or later, or Internet Explorer v5.0 or 
later.

4. Make sure Java is enabled in your Internet browser.

For more information on setting up the Fiery 3850C and your network, see the 
Configuration Guide.
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This chapter provides troubleshooting tips.

On a Windows computer
Make sure the printer is on line.

Setting up printing on Windows NT or Windows 2000/XP 
computers

If you have problems installing the Fiery 3850C with Windows NT, try installing 
another PostScript printer, and then install the Fiery 3850C. Installing another printer 
ensures that all files are properly installed and available. For instructions, see your 
Windows NT documentation.

For additional information about problems you may encounter using the Adobe 
Printer Driver for Windows NT 4.0, see the Adobe README file (readmeNT.wri) 
included in English\Prntdrvr\Ps_drvr\Win_NT4x on the User Software CD.

For Windows 2000XP, see your Windows 2000 or Windows XP documentation.

Reinstalling the Adobe PostScript Printer Driver on 
Windows 9x/Me

If you are reinstalling the Adobe PostScript Printer Driver, delete any previous versions 
and related files before installing. 

For additional information about problems you may encounter using the Adobe 
Printer Driver for Windows 9x/Me, see the Adobe README file (readme9x.wri) 
included in English\Prndrvr\Ps_drvr\Win_9x on the User Software CD.

Troubleshooting
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Problems with the Fiery utilities on Windows computers

1. If you are using Windows 9x/Me, make sure that IPX/SPX and TCP/IP networking 

protocols are both enabled. 

See “Completing the Windows 9x/Me IPX/SPX or IPX (Novell) connection” on 
page 12.

2. If you are using Windows NT or Windows 2000/XP, make sure the TCP/IP 

networking protocol is enabled.

3. Make sure that the connection is configured correctly for your site.

To check the current configuration, launch a Fiery utility and choose Open from the 
File menu. Select the Fiery 3850C and click Modify to see current settings. If the 
settings are incorrect, you can change them in this dialog box.

On a Mac OS computer
Make sure the printer is on line.

Setting up the Fiery 3850C in the Chooser

If auto-setup does not work and you are prompted to select the PPD, select the 
appropriate Fiery 3850C file in your System folder:Extensions:Printer Descriptions 
folder.

Select “Fiery 3850C.”
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Installing screen fonts

If you experience problems installing the PostScript screen fonts from the 
User Software CD to the System folder:Fonts folder, try the following:

1. Quit all applications and close all windows.

2. Create a new folder and name it “Uninstalled Fonts.”

This folder must be located outside of the System folder.

3. Move fonts that you are not using from the System folder:Fonts folder to the 

Uninstalled Fonts folder.

4. Install the fonts from the User Software CD to a folder called CD fonts. Copy the fonts 

to the System folder:Fonts folder.

5. Create an alias to the System folder:Fonts folder and to the Uninstalled Fonts folder.

6. Place both aliases on your desktop.

7. When necessary, use the aliases to open both folders and move fonts between them.

If you have any applications running, you must quit and relaunch them in order to 
view and use the newly installed fonts.

Alternatively, you can try combining fonts from multiple suitcases into a single 
suitcase.
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